This document is copyrighted with all rights reserved. Under the copyright laws, this document may not be copied in whole or in part or reproduced in any other media without the express written permission of Coherent, Inc. Permitted copies must carry the same proprietary and copyright notices as were affixed to the original. This exception does not allow copies to be made for others, whether or not sold, but all the material purchased may be sold, given or loaned to another person. Under the law, copying includes translation into another language.

Coherent, the Coherent Logo, and PowerMax are trademarks or registered trademarks of Coherent, Inc. All other trademarks or registered trademarks are the property of their respective owners.

Patents referenced in this documents were active as of the printing date of the manual (see last page for date). The patents referenced herein may have expired. You are advised to check to see if the patents are still active: [http://portal.uspto.gov/external/portal/pair](http://portal.uspto.gov/external/portal/pair).

Every effort has been made to ensure that the data given in this document is accurate. The information, figures, tables, specifications and schematics contained herein are subject to change without notice. Coherent makes no warranty or representation, either expressed or implied with respect to this document. In no event will Coherent be liable for any direct, indirect, special, incidental or consequential damages resulting from any defects in its documentation.

**Technical Support**

**In the US:**

Should you experience difficulties with your product, or need technical information, please visit our website: [www.Coherent.com](http://www.Coherent.com). You can obtain additional support by either telephoning our Technical Support Hotline at 1.800.343.4912, or e-mailing our Support Team at [support.instruments@Coherent.com](mailto:support.instruments@Coherent.com). Telephone coverage is available Monday through Friday (except U.S. holidays).

If you call outside our office hours, your call will be taken by our answering system and will be returned when the office reopens.

If there are technical difficulties with your product that cannot be resolved by support mechanisms outlined above, please e-mail or telephone Coherent Technical Support with a description of the problem and the corrective steps attempted. When communicating with our Technical Support Department via the web or telephone, the Support Engineer responding to your request will require the model and Laser Head serial number of your laser system.

**Outside the US:**

If you are located outside the U.S., visit our website for technical assistance, or telephone our local Service Representative. Representative phone numbers and addresses can be found on the Coherent website: [www.Coherent.com](http://www.Coherent.com).

Coherent provides telephone and web technical assistance as a service to its customers and assumes no liability thereby for any injury or damage that may occur contemporaneous with such services. These support services do not affect, under any circumstances, the terms of any warranty agreement between Coherent and the buyer. Operation of any Coherent laser with any of its interlocks defeated is always at the operator's own risk.
TABLE OF CONTENTS

Signal Words and Symbols in this Manual ................................................................. vii
  Signal Words ......................................................................................................... vii
  Symbols ................................................................................................................... viii
Preface ...................................................................................................................... ix
RoHS Compliance .................................................................................................... ix
Export Control Laws Compliance ............................................................................. ix
Publication Updates ................................................................................................ ix

Section One: Safety ................................................................................................ 1-1
  Waste Electrical and Electronic Equipment (WEEE, 2002) ...................................... 1-1
  Declaration of Conformity ................................................................................... 1-1

Section Two: Description ..................................................................................... 2-1
  Introduction ........................................................................................................... 2-1
  Product Overview ............................................................................................... 2-1
    Product Features .............................................................................................. 2-1
    Software Features ............................................................................................ 2-2
  Technical Description ......................................................................................... 2-3
    Thermopile Technology ................................................................................... 2-3
      Long-Pulse Energy Measurement With a Thermopile .................................. 2-4
    Semiconductor Technology .......................................................................... 2-5
    Applying Wavelength Compensation Accuracy .......................................... 2-7

Section Three: Operation .................................................................................... 3-1
  LED Status Indicators ....................................................................................... 3-1
  PowerMax-USB LED Lights ............................................................................ 3-1
  PowerMax-RS LED Lights ............................................................................... 3-2
  Powering PowerMax-RS Sensors ...................................................................... 3-2
  Extending Cable Length ................................................................................... 3-3
  How to Take a Power Measurement ................................................................. 3-3
    Measuring Power With a PowerMax-USB Thermopile Sensor .................. 3-4
    Measuring Power With a PowerMax-RS Thermopile Sensor ...................... 3-5
  Zeroing ............................................................................................................... 3-7
  Setting the Wavelength ..................................................................................... 3-7
  Using the Software ............................................................................................ 3-8
  Front Panel ......................................................................................................... 3-8
    Keyboard Shortcuts ....................................................................................... 3-8
    Select Sensor ................................................................................................. 3-9
    Start/Stop Data Collection ............................................................................ 3-10
    Trending Chart ............................................................................................... 3-10
    Histogram Chart ............................................................................................ 3-11
    Tuning Chart ................................................................................................. 3-12
    Alignment Target Chart .............................................................................. 3-13
<table>
<thead>
<tr>
<th>Feature</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Synchronized Trending Chart</td>
<td>3-13</td>
</tr>
<tr>
<td>Large Display Chart</td>
<td>3-16</td>
</tr>
<tr>
<td>Graph Palette</td>
<td>3-16</td>
</tr>
<tr>
<td>Live Reading</td>
<td>3-17</td>
</tr>
<tr>
<td>Wavelength</td>
<td>3-18</td>
</tr>
<tr>
<td>Live Data Averaging</td>
<td>3-18</td>
</tr>
<tr>
<td>Mean</td>
<td>3-19</td>
</tr>
<tr>
<td>Min</td>
<td>3-20</td>
</tr>
<tr>
<td>Counts</td>
<td>3-20</td>
</tr>
<tr>
<td>Std Dev</td>
<td>3-21</td>
</tr>
<tr>
<td>Max</td>
<td>3-22</td>
</tr>
<tr>
<td>Area</td>
<td>3-22</td>
</tr>
<tr>
<td>Zero Sensor</td>
<td>3-23</td>
</tr>
<tr>
<td>Sample Collection</td>
<td>3-23</td>
</tr>
<tr>
<td>Mode</td>
<td>3-24</td>
</tr>
<tr>
<td>Sample Size</td>
<td>3-24</td>
</tr>
<tr>
<td>Reset</td>
<td>3-25</td>
</tr>
<tr>
<td>Reset Error</td>
<td>3-25</td>
</tr>
<tr>
<td>Gain Correction</td>
<td>3-26</td>
</tr>
<tr>
<td>Collection Mode</td>
<td>3-27</td>
</tr>
<tr>
<td>Collection Interval</td>
<td>3-27</td>
</tr>
<tr>
<td>Log Data to File</td>
<td>3-28</td>
</tr>
<tr>
<td>Log Data File</td>
<td>3-28</td>
</tr>
<tr>
<td>Menus</td>
<td>3-29</td>
</tr>
<tr>
<td>File Menu</td>
<td>3-30</td>
</tr>
<tr>
<td>Settings Menu</td>
<td>3-34</td>
</tr>
<tr>
<td>View Menu</td>
<td>3-37</td>
</tr>
<tr>
<td>Window Menu</td>
<td>3-40</td>
</tr>
<tr>
<td>Help Menu</td>
<td>3-42</td>
</tr>
</tbody>
</table>

**Section Four: Advanced Procedures**

PowerMax Communications Through HyperTerminal .................................................. 4-1

**Section Five: Host Interface**

Introduction ........................................................................................................ 5-1
Message Terminators ............................................................................................. 5-2
  Messages Received by the Sensor .................................................................... 5-2
  Messages Sent by the Sensor ......................................................................... 5-2
Host Command Quick Reference ............................................................................ 5-3
SCPI Interface Section ....................................................................................... 5-5
Syntax and Notation Conventions ..................................................................... 5-5
Commands and Queries ....................................................................................... 5-6
  SCPI Common Commands ............................................................................... 5-6
  System Options ........................................................................................... 5-6
Error Record Reporting and Collection ............................................................ 5-8
Measurement Setup and Control ........................................................................ 5-10
Measurement Data Record Item Select and Format .......................................... 5-12
Table of Contents

Measurement Data Record Reading ............................................................... 5-14
Sensor Information ......................................................................................... 5-16
Legacy LaserPAD/SSIM Interface Section...................................................... 5-17
 Commands and Queries ................................................................................ 5-17
LaserPAD/SSIM Streaming Data Record Format ............................................. 5-21
Data Streaming Transmission Interface Gating Section .................................. 5-22
 Streaming Measurement Data ....................................................................... 5-22
 Commands and Queries ................................................................................ 5-22
Operational Parameters .................................................................................... 5-23
RS232 Port Settings .......................................................................................... 5-24

Section Six: Calibration and Warranty ......................................................... 6-1
 Calibration ..................................................................................................... 6-1
Coherent Calibration Facilities and Capabilities ............................................. 6-1
Limited Warranty ............................................................................................. 6-2
Extended Warranty ........................................................................................... 6-2
Warranty Limitations ...................................................................................... 6-3
Obtaining Service ............................................................................................. 6-3
Product Shipping Instructions ........................................................................... 6-4

Appendix A: Specifications ............................................................................. A-1
Appendix B: Troubleshooting and Error Messages ........................................ B-1
Index ............................................................................................................... Index-1

LIST OF FIGURES

1-1. Waste Electrical and Electronic Equipment Label ....................................... 1-1
2-1. Saturation Power and Minimum Power for PowerMax-USB UV/VIS Quantum
     Sensor ...................................................................................................... 2-6
2-2. Photo Sensitivity Temperature Characteristics ........................................... 2-7
2-3. RV Spectral Correction for Thermal Sensors (Normalized to Calibration
     Wavelength) .............................................................................................. 2-8
3-1. Front Panel ............................................................................................... 3-8
3-2. Dropdown Menus ..................................................................................... 3-29
3-3. File Menu ................................................................................................ 3-30
3-4. Settings Menu ........................................................................................ 3-34
3-5. View Menu ............................................................................................ 3-37
3-6. Window Menu ........................................................................................ 3-40
3-7. Help Menu ............................................................................................. 3-42
LIST OF TABLES

2-1. Wavelength Compensation Accuracy ................................................................. 2-8
3-1. PowerMax-USB LED Light Conditions ............................................................. 3-1
3-2. PowerMax-RS LED Light Conditions ............................................................... 3-2
3-3. Keyboard Shortcuts ......................................................................................... 3-8
5-1. Host Command Quick Reference .................................................................... 5-3
5-2. Status Condition Character Definitions ......................................................... 5-6
5-3. Error Codes and Description Strings .............................................................. 5-8
5-4. Non-SIMM Measurement Data Record Formats ............................................. 5-12
5-5. Flags Character Definitions ............................................................................. 5-13
5-6. Measurement Data Record Formats ............................................................... 5-14
5-7. Flags Character Definitions ............................................................................. 5-15
5-8. Measurement Data Record Formats ............................................................... 5-21
5-9. Data Streaming Transmission Rates ............................................................... 5-23
5-10. Operational Parameters .................................................................................. 5-23
5-11. RS232 Port Settings ...................................................................................... 5-24
6-1. Coherent Service Centers ............................................................................... 6-4
This documentation may contain sections in which particular hazards are defined or special attention is drawn to particular conditions. These sections are indicated with signal words in accordance with ANSI Z-535.6 and safety symbols (pictorial hazard alerts) in accordance with ANSI Z-535.3 and ISO 7010.

Signal Words and Symbols in this Manual

Four signal words are used in this documentation: DANGER, WARNING, CAUTION and NOTICE.

The signal words DANGER, WARNING and CAUTION designate the degree or level of hazard when there is the risk of injury:

---

**DANGER!**
Indicates a hazardous situation that, if not avoided, will result in death or serious injury. This signal word is to be limited to the most extreme situations.

---

**WARNING!**
Indicates a hazardous situation that, if not avoided, could result in death or serious injury.

---

**CAUTION!**
Indicates a hazardous situation that, if not avoided, could result in minor or moderate injury.

---

The signal word “NOTICE” is used when there is the risk of property damage:

---

**NOTICE!**
Indicates information considered important, but not hazard-related.

---

Messages relating to hazards that could result in both personal injury and property damage are considered safety messages and not property damage messages.
The signal words **DANGER**, **WARNING**, and **CAUTION** are always emphasized with a safety symbol that indicates a special hazard, regardless of the hazard level:

**This symbol is intended to alert the operator to the presence of important operating and maintenance instructions.**

**This symbol is intended to alert the operator to the danger of exposure to hazardous visible and invisible laser radiation.**

**This symbol is intended to alert the operator to the presence of dangerous voltages within the product enclosure that may be of sufficient magnitude to constitute a risk of electric shock.**

**This symbol is intended to alert the operator to the danger of Electro-Static Discharge (ESD) susceptibility.**

**This symbol is intended to alert the operator to the danger of crushing injury.**

**This symbol is intended to alert the operator to the danger of a lifting hazard.**
This manual has user information for the Coherent PowerMax™ meterless power sensors and the PowerMax PC software.

This Coherent product is RoHS compliant.

It is the policy of Coherent to comply strictly with U.S. export control laws.

Export and re-export of lasers manufactured by Coherent are subject to U.S. Export Administration Regulations, which are administered by the Commerce Department. In addition, shipments of certain components are regulated by the State Department under the International Traffic in Arms Regulations.

The applicable restrictions vary depending on the specific product involved and its destination. In some cases, U.S. law requires that U.S. Government approval be obtained prior to resale, export or re-export of certain articles. When there is uncertainty about the obligations imposed by U.S. law, clarification must be obtained from Coherent or an appropriate U.S. Government agency.

Products manufactured in the European Union, Singapore, Malaysia, Thailand: These commodities, technology, or software are subject to local export regulations and local laws. Diversion contrary to local law is prohibited. The use, sale, re-export, or re-transfer directly or indirectly in any prohibited activities are strictly prohibited.

To view information that may have been added or changed since this publication went to print, connect to www.Cohherent.com.
SECTION ONE: SAFETY

Carefully review the following safety information to prevent personal injury or damage to this product or any equipment connected to it. There are no user-serviceable parts in Coherent PowerMax meterless power sensors. For service information, refer to “Obtaining Service” (p. 6-3).

---

**WARNING!**
Do not operate the system if its panels are removed or any of the interior circuitry is exposed.

---

**WARNING!**
Do not operate the system in wet or damp conditions, or in an explosive atmosphere.

---

**NOTICE!**
Do not operate the system if there are suspected failures. Refer damaged units to qualified Coherent service personnel.

---

**Waste Electrical and Electronic Equipment (WEEE, 2002)**

The European Waste Electrical and Electronic Equipment (WEEE) Directive (2002/96/EC) is represented by a crossed-out garbage container label (Figure 1-1). The purpose of this directive is to minimize the disposal of WEEE as unsorted municipal waste and to facilitate its separate collection.

![Figure 1-1. Waste Electrical and Electronic Equipment Label](image)

**Declaration of Conformity**

Declaration of Conformity certificates are available upon request.
SECTION TWO: DESCRIPTION

Introduction

Coherent PowerMax-USB and PowerMax-RS sensors are the world’s first laser power sensors that use state of the art microelectronics miniaturization techniques and integrate an entire instrument within a USB 2.0 or RS232 cable connector. Specifically, PowerMax-USB and PowerMax-RS sensors have all the signal processing and power measurement electronics normally in a LabMax meter and connect directly to a PC with plug-and-play functionality. Ideally adapted for low- and high-volume embedded sensor applications, Coherent’s new family of sensors removes the need for a separate meter box, thus delivering a significant savings in cost and space, but with no decrease whatsoever in performance.

This measurement platform can also be used to measure the energy in a long laser pulse—normally greater than 1 millisecond in pulse width—by integrating the output of a thermopile sensor.

Coherent’s PowerMax PC application software supplies a virtual instrument interface for sensors that enable the operator to take laser power readings, log data, and compute measurement statistics. Users can also write their own software using host interface commands that control all aspects of power meter operation.

For the first time, separate electronics are no longer required between the sensor and a PC. For those customers who can use a PC for monitoring laser power, these sensors make available significant cost savings, space savings, and no decrease in performance.

Product Overview

Product Features

- PowerMax-USB provides direct USB 2.0 connection to a PC. Power is supplied through a USB connection.
- PowerMax-RS provides RS232 connectivity. Power input is supplied by a +5VDC input (power supply is available as an optional accessory).
- Instrumentation platform is compatible with thermopile and optical sensors and can be adapted to most power sensors that Coherent manufactures.
• Displays beam position with position-sensing quadrant thermopiles (for example LM-model sensors like the LM-10).

• High resolution 24-bit A/D converter supports four digits of resolution and measurement accuracy equivalent to that found in Coherent's LabMax meters.

• Sensors include spectral compensation for accurate use at wavelengths that are different from the calibration wavelength. Each sensor receives an unique spectral compensation curve specific to the responsivity of its specific element, as well as transmission characterization of any related optics.

• Thermopile sensors include a speed-up algorithm that speeds up the normal response of the thermopile detector without overshoot.

• LED status indicators inside USB and RS232 connectors give health-and-status information.

• Thermopile sensors offer long-pulse joules capability.

Software Features

Plug-and-play application software is supplied standard and includes the following features:

• Trending

• Statistics (mean, minimum, maximum, and standard deviation) and log batch to file.

• Tuning

• Display beam position on position-sensing thermopiles and log results to file
Description

- Histogram
- Simultaneously operate several sensors
- Perform synchronized ratiometry (A/B analysis). Trend and log results to file.
- For LaserPAD or SSIM customers, the host command set includes drop-in compatibility.

For system integrators and for implementations that include customer-written software, the sensors include a complete command set that is easy to access:

- Utilized a Window USB driver and supports simple ASCII host commands for remote interfacing using both PowerMax-USB and PowerMax-RS sensors.
- Using customer-written software, the remote interfacing host command set permits sensors to be remotely controlled.
- National Instruments™ LabVIEW™ driver is supplied for easy LabVIEW integration.

Technical Description

Thermopile Technology

Thermopile sensors are a great all-purpose technology suitable for many lasers. They are used for measuring CW laser power, average power in pulsed lasers, and are frequently used to integrate the energy of long pulses. Thermopile sensors absorb incident laser radiation and convert it into heat. This heat ultimately flows to a heatsink that is held at ambient temperature by either convection-cooling or water-cooling. The temperature difference between the absorber and the heatsink is changed into an electrical signal by a thermocouple junction.

Thermopiles operate across a wide range of input powers, and unlike a photodiode-based sensor they will not saturate. The spectral range is dependent on the coating applied to absorb the laser power. The coating used on many thermopiles is broadband in nature and is relatively flat from the ultraviolet through the infrared.

These sensors have normal response times on the order of several seconds for a low power sensor and up to one minute for a kilowatt sensor. The exponential nature of the natural thermopile output permits one to electronically increase the voltage to its final value ahead of the actual sensor signal using a software algorithm. We
typically call this capability a “speed-up” algorithm. When combined with the PowerMax-USB and PowerMax-RS circuitry, a speed-up algorithm can be applied to provide a much faster response—on the order of seconds or less for most thermopile sensors. This feature can be turned on and off in the software.

Coherent has two main types of thermopile sensors:

- The *LM Model* line uses an unique thermopile disk in which the thermocouples are divided into four quadrants, letting the sensors provide beam position information in addition to power measurement.
- The *PM Model* line incorporates traditional thermopile disks that supply power measurement without beam position information.

PowerMax-USB and PowerMax-RS sensors can use both types of thermopile sensors.

**Long-Pulse Energy Measurement With a Thermopile**

Thermopile sensors are most commonly for average power measurements on pulsed and CW lasers. A unique function of thermopile sensors is the ability to integrate the power of a single “long” laser pulse (*long pulse* refers to pulses roughly 1 millisecond up to several seconds in pulse length). The instrumentation analyzes the output of
the thermopile and applies the integration through the use of an algorithm that results in a Joules reading. This lets the thermopile measure the energy of single pulses between 1 millisecond and 10 seconds in length, and with energies from millijoules to hundreds of Joules. The measurement accuracy of this mode is typically better than ± 3% when performed with PowerMax-USB and PowerMax-RS sensors.

This capability is very useful for what are commonly called long-pulse medical or industrial type lasers. Common applications for this type of measurement are in the medical field—especially skin resurfacing and hair removal—and in material processing applications, for example laser welding. These laser systems frequently use high-energy lasers that have large beam sizes and relatively long pulses.

This type of measurement requires careful selection of the applicable power sensor, based upon the laser pulse being measured. A good “rule of thumb” for using a thermopile for this type of measurement is to compare the maximum pulse energy you need to measure (in Joules) with the maximum power rating of a sensor (in Watts).

Frequently a sensor such as the PM150-50C is best for these measurements. It features a large 50 mm aperture size, can handle pulse energies up to 150J, and can be used air-cooled for single pulse energy measurements. A PM150-50C normally needs to be water-cooled for continuous power measurements. The PS19Q sensors, on the other hand, permit long-pulse measurements down into the mJ level.

For an up-to-date list of all compatible sensors and their specifications, go to our website: www.Coherent.com/LMC.

Semiconductor Technology

Semiconductor photodiode-based sensors convert incident photons into current that can be measured by our instrumentation. We normally refer to these devices as optical sensors or quantum sensors. The photodiodes used in these types of sensors offer high sensitivity and low noise, enabling them to detect very low light levels. The UV/VIS optical sensor in the PowerMax-USB line is designed to measure power of CW sources, as well as the average power of pulsed sources, as long as the repetition rate is above 100 pps. Photodiodes also have a fast response time, making this sensor convenient for tuning and peaking lasers.

These types of sensors have several orders of magnitude higher sensitivity than thermopile sensors and are quite stable. They do, however, suffer from photocurrent saturation. The UV/VIS sensor
incorporated into the PowerMax-USB product line includes an attenuating filter that allows the sensor to be used into the hundreds of milliwatt level without saturation. This ND filter, and the light shield threaded onto the front of the sensor, also help to block stray light, thereby resulting in a lower noise floor.

We incorporate spectral compensation in the PowerMax-USB and PowerMax-RS UV/VIS sensor to give accurate measurements across the 325 to 1065 nm spectrum. Because the spectral response of the ND filter and photodiode varies significantly across this wavelength range, always check the maximum measurable power at the wavelength of use to make sure the sensor is not being saturated. Figure 2-1, below, indicates the maximum and minimum measurable power levels by wavelength.

The following curve plots the maximum measurable power—which is the saturation level of the photodiode—as well as the minimum recommended power level, by wavelength.

![Figure 2-1. Saturation Power and Minimum Power for PowerMax-USB UV/VIS Quantum Sensor](image)

**UV/VIS Temperature Linearity:** Like all silicon photodiodes, the UV/VIS Quantum sensor has temperature sensitivity in the infrared region. At 1064 nm, for example, it has a 0.5%/°C thermal coefficient. Because of the electronics inside the sensor, measurement error up to 2% is present at 1064 nm after a 10-minute warm-up time. Additional error can be present if the ambient measurement environment is different from the calibration wavelength shown on the calibration certificate.
In practice, wavelengths shorter than 1000 nm have insignificant effects caused by temperature.

The following figure references the thermal coefficient at the wavelength of use.

![Photo Sensitivity Temperature Characteristics](image)

**Figure 2-2. Photo Sensitivity Temperature Characteristics**

**Applying Wavelength Compensation Accuracy**

Overall measurement accuracy is a combination of:


- Wavelength compensation accuracy—refer to Table 2-1 (p. 2-8).

The combined accuracy is based upon practices outlined in the *National Institute of Standards Guidelines for Evaluating and Expressing Uncertainty* (NIST Technical Note 1297, 1994 Edition). The combined accuracy of the measurement is calculated by using the law of propagation of uncertainty using the “root-sum-of-square” (square root of the sum of squares), sometimes described as “summing in quadrature” where:

\[
\text{Measurement Accuracy} = \sqrt{U^2 + W^2}
\]

where:

- \(U\) = Percent Calibration Uncertainty
- \(W\) = Wavelength Accuracy
Example:

PowerMax-USB LM-10 used at 1064 nm

\[ U = 2\% \]

\[ W = 1.5\% \]

Measurement Accuracy = \( \sqrt{2^2 + 1.5^2} = \sqrt{4 + 2.3} = 2.5\% \)

Coherent uses three primary coatings to capture the incident radiation on our thermal sensors. The specifications for each sensor list which coating is used. Typical wavelength ranges and response curves for these coatings are shown in Figure 2-3, below. Each sensor has a spectral curve created from reflectance measurements taken with spectrometers. The reflectance data are converted into a wavelength compensation look-up table that is loaded into the sensor. This data is accessed by selecting a wavelength of operation in the software.

![Figure 2-3. RV Spectral Correction for Thermal Sensors (Normalized to Calibration Wavelength)](image)

Table 2-1 lists the spectral compensation accuracy for each type of sensor.

<table>
<thead>
<tr>
<th>Sensor</th>
<th>Wavelength Compensation Accuracy</th>
<th>Calibration Wavelength (nm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>All PM- and LM-model thermopiles</td>
<td>( \pm 1.5% )</td>
<td>10600</td>
</tr>
<tr>
<td>PS model</td>
<td>( \pm 1.5% )</td>
<td>514</td>
</tr>
<tr>
<td>UV/VIS optical model</td>
<td>( \pm 4% ) (325 to 900 nm) ( \pm 5% ) (900 to 1065 nm)</td>
<td>514</td>
</tr>
</tbody>
</table>

a. Refers to wavelengths different from the calibration wavelength.
SECTION THREE: OPERATION

In this section:

- LED status indicators (this page)
- Powering PowerMax-RS sensors (p. 3-2)
- Extending cable length (p. 3-3)
- How to take a power measurement (p. 3-3)
- Zeroing (p. 3-7)
- Setting the wavelength (p. 3-7)
- Using the software (p. 3-8)

**LED Status Indicators**

Blue LED lights are contained within the PowerMax-USB and PowerMax-RS connectors to supply health-and-status information.

**PowerMax-USB LED Lights**

![Image of PowerMax-USB LED lights]

**Table 3-1. PowerMax-USB LED Light Conditions**

<table>
<thead>
<tr>
<th>LED Light Condition</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>No light visible</td>
<td>If the PowerMax-USB sensor is connected to the PC but there are no visible lights, the sensor is not powering up properly. Test the sensor on another USB port and if that does not solve the problem, contact Coherent for service—refer to Table 6-1 (p. 6-4) for contact information.</td>
</tr>
<tr>
<td>Lights flashing slowly (0.5 Hz)</td>
<td>Sensor is functioning; however, the driver has not been properly loaded. First, make sure power is being properly applied to the USB port. If that does not solve the problem, remove the sensor from the USB port and reinstall the software from the CD that shipped with the product (or download the latest software from our website: <a href="http://www.Coherent.com">www.Coherent.com</a>).</td>
</tr>
<tr>
<td>Lights slowing ramping up and down in intensity</td>
<td>Sensor is functioning and the driver has been properly loaded.</td>
</tr>
<tr>
<td>Lights flashing fast (10 Hz)</td>
<td>The sensor is taking power measurements and sending data over the host port.</td>
</tr>
</tbody>
</table>
PowerMax-RS LED Lights

The PowerMax-RS sensor is powered by a +5 VDC power supply input.

Table 3-2. PowerMax-RS LED Light Conditions

<table>
<thead>
<tr>
<th>LED Light Condition</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>No light visible</td>
<td>If + 5VDC has been applied to the PowerMax-USB sensor but there are no visible lights in the connector, the sensor is not powering up properly. Contact Coherent for service—refer to Table 6-1 (p. 6-4) for contact information.</td>
</tr>
<tr>
<td>Lights slowing ramping up and down in intensity</td>
<td>Power has been applied to the sensor and it is functioning.</td>
</tr>
<tr>
<td>Lights flashing fast (10 Hz)</td>
<td>The sensor is taking power measurements and sending data over the host port.</td>
</tr>
</tbody>
</table>
**Extending Cable Length**

*USB sensors*: The PowerMax-USB cable is 2.5 meters long. USB hubs can be employed to increase the length of the cable. The USB standard permits up to five hubs—connected in series with 5-meter cables connecting the hubs—thus providing a maximum range of 27.5 meters.

There are also active 5-meter USB extension cables on the market that perform as if they were a USB hub, but for just a single USB sensor. (Feel free to contact Coherent for advice related to particular hubs we have tested in-house.)

*RS sensors*: The RS cable is 300 mm long. It is intended to be used with a standard off-the-shelf RS232 extension cable to extend the length.

**How to Take a Power Measurement**

This section presents two “mini-tutorials” that tell how to connect a PowerMax-USB or PowerMax-RS sensor to your PC and start taking measurements using the PowerMax PC software.

For instructions on communicating with the sensor directly via host commands, refer to “Section Five: Host Interface” (p. 5-1).

Tutorials include:

- Measuring power with a PowerMax-USB thermopile sensor (p. 3-4).
- Measuring power with a PowerMax-RS thermopile sensor (p. 3-5).

**WARNING!**
Follow all laser safety procedures. The laser must be switched OFF or shuttered before running the tutorials given in this section.
This tutorial describes how to take a power measurement using a PowerMax-USB thermopile sensor.

**WARNING!**
Confirm the laser is switched OFF or shuttered before starting this tutorial.

1. Install the PowerMax PC software (for complete installation instructions, refer to the “Software Installation” section of the *PowerMax-USB/RS Software Installation and Quick Start Guide*—part number 1169931—that shipped with your system).

2. Plug in the PowerMax-USB sensor.

3. Confirm the blue LEDs on the USB connector are lit and slowly ramping up and down in intensity (which signifies the sensor is operating and the driver is correctly loaded).

4. Run the PowerMax PC software.

5. Select the sensor serial number from the Select Sensor dropdown menu. In the example at right, the selected sensor serial number is 0747K09R.
Measuring Power With a PowerMax-RS Thermopile Sensor

This tutorial describes how to take a power measurement using a PowerMax-RS thermopile sensor.

WARNING!
Confirm the laser is switched OFF or shuttered before starting this tutorial.

1. Install the PowerMax PC software (for complete installation instructions, refer to the “Software Installation” section of the PowerMax-USB/RS Software Installation and Quick Start Guide—part number 1169931—that shipped with your system).

2. Plug the PowerMax-RS sensor into an available RS232 Com port on the computer.
3. Plug the +5V DC power supply cable into the sensor power cable and the power supply into a wall electrical outlet. (The power supply is available from Coherent as an optional accessory—part number 1105557.)

4. Confirm the blue LEDs on the RS connector are lit and slowly ramping up and down in intensity (which signifies the sensor is working).

5. Run the PowerMax PC software.

6. Click *Add RS232/Serial Sensor* from the Settings dropdown menu.

7. From the Add Serial Sensor screen, select the Com port to which the PowerMax-RS sensor is attached. The Com port number is automatically determined by the computer. (If needed, you can check in Device Manager for available Com ports.) In this example, the selected Com port is 2.

When the Com port is selected, the PowerMax PC software will scan that port and identify the connected sensor. As long as the sensor is correctly connected and powered up, the serial number of the sensor will be available for selection from the dropdown menu in the software. In this example, the connected sensor is *0341I09R*. 
8. Put the sensor into the beam path, making sure the laser is turned OFF or shuttered until the sensor is zeroed.

9. Press the Zero Sensor button to zero out any offset in the sensor.

10. Press the Start Data Collection button and then turn ON the laser to start taking power measurements.

Zeroing

Pressing the Zero button implements the Zero function and sets the current sensor input as the baseline for future measurements. It is recommended that you zero the sensor after first turning it on and before starting any new set of power measurements.

When a zero procedure is in process, no other button events are queued or activated until the procedure ends. The zero procedure immediately stops if the sensor is disconnected or if an error happens.

Normally you should press the Zero button while the laser is turned off, or while the laser beam is blocked. If a finite power level is present at the sensor, the instrumentation will try to null it out.

The sensor can only zero a finite level of offset equivalent to approximately 10% of full scale range.

If zeroing is unsuccessful—which means the power input is too large to null—re-zero in a more stable environment or select a different range.

Setting the Wavelength

The wavelength must always be set for accurate power measurements. This can be done either in the PowerMax PC application software or over the host port via a host command.
Using the Software

Front Panel

The Front panel (Figure 3-1) is the first screen that appears when the software is started. From here you can enter parameters, select modes, change ranges, start/stop data acquisition, and view the output in a chart format.

![Front Panel](image)

Figure 3-1. Front Panel

Each function accessed through the Front panel is discussed, starting next.

Keyboard Shortcuts

The following table shows available shortcuts for several standard functions:

<table>
<thead>
<tr>
<th>Function</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exit program</td>
<td>&lt;Ctrl&gt;+&lt;Q&gt;</td>
</tr>
<tr>
<td>Open new Front panel</td>
<td>&lt;Ctrl&gt;+&lt;N&gt;</td>
</tr>
<tr>
<td>Print window</td>
<td>&lt;Ctrl&gt;+&lt;P&gt;</td>
</tr>
<tr>
<td>Show context help</td>
<td>&lt;Ctrl&gt;+&lt;H&gt;</td>
</tr>
<tr>
<td>View full application</td>
<td>&lt;Ctrl&gt;+&lt;F&gt;</td>
</tr>
<tr>
<td>View saved data file</td>
<td>&lt;Ctrl&gt;+&lt;V&gt;</td>
</tr>
</tbody>
</table>
Select Sensor

Lists all the connected PowerMax sensors that can be selected for use by the current Front panel.

The serial numbers of all attached PowerMax sensors are shown in the dropdown menu, with the visible serial number indicating which sensor is the current data source.

Notes:

- After attaching a sensor, it can take several seconds for the serial number to appear on the list.
- Sensors connected to your computer but already controlled by a Front panel will appear grayed out (not selectable) in the Select Sensor dropdown list. If you de-select a sensor in a Front panel, the Select Sensor dropdown list automatically updates and that sensor will then be available for selection.
- By default, RS232 ports do not automatically appear on this dropdown menu. For information about selecting a RS232 port, refer to “Add RS232/Serial Sensor” (p. 3-35).
Start/Stop Data Collection

Enables/disables sample collection, including:

- The Trending chart
- Synchronized trending, if enabled
- The Histogram chart
- The Tuning chart
- The Live Reading indicator
- All statistic indicators
- Data logging, if active

Trending Chart

Displays the data received from the PowerMax sensor.
The axis scale points—(x) and (y)—can be directly edited by clicking on them and entering the desired value. Example: Clicking on the first x-axis point and setting it to 0 (zero) displays the data from beginning to present.

**Autoscale**
- Checked: Y-axis Autoscale is active.
- Unchecked: The graph displays the y-axis in fixed scale.

**Histogram Chart**
Displays a histogram of measurement values in the sample buffer. The sample buffer is controlled by the Sample Size. For example, with a sample size of 100, up to 100 samples are used in the histogram. When more than 100 samples have been collected, only the 100 most recent samples are displayed.

**Number of Bins**
Sets the number of bins along the x-axis used to plot the histogram data.
**Tuning Chart**

Displays two values on the Tuning meter:

- **Green** pointer = current measurement value (also displayed as a value in the Current Value window at the bottom left of the Tuning chart)
- **Red** pointer = maximum measured value (also displayed as a value in the Maximum window at the bottom right of the Tuning chart)

**Tuning Scale**

Use this button to select the scaling range of the Tuning meter.

- **Min - Max**: Sets the low end of the scale range to the minimum value in the current data set and the high end of the scale range to the highest value measured since the last reset.
- **Zero - Max**: Sets the low end of the scale to zero and the high end of the scale to the highest value measured since the last reset.

**Reset Maximum Button**

Click to reset the maximum value.
Alignment Target Chart

(Position-sensing thermopile sensors only)

The target represents the bull's-eye view of the laser beam position of the selected sensor. Position values are scaled and the outer ring refers to the aperture radius.

The dot on the target represents the position of the beam on the surface of the sensor. As the beam nears the edge of the aperture, the dot will display near the edge of the bull's-eye. This feature is useful when setting up the sensor for a measurement, especially with non-visible laser beams.

The Alignment Target tab only appears if a thermopile quad sensor is selected as the current data source.

Synchronized Trending Chart

When multiple sensors are available, this tab provides synchronized plotting of two sensors on the same chart. This screen also provides the option of performing math—such as ratiometry (A/B)—using two sensors.

The Synchronized Trending tab only appears if two PowerMax-USB sensors are available for control by the application. If you have two sensors connected—and two windows open—the Synchronized Trending tab will not be visible until you close one of the two windows.
Numerical Indicators

These numerical indicators display the latest readout of both sensors (in Watts, Joules, or dBm, depending on measurement mode), as well as the optional synchronized calculated math value, if synchronized data collection is enabled.

Setup Button

Clicking the Setup button displays the following screen:

Options on this screen include:

- Selecting/de-selecting the second sensor to be used for synchronized data collection
- Changing the Synchronization Calculation equation.

Sensor 1 (a)

Lists the serial number of the primary PowerMax sensor in use by the current Front panel.
Sensor 2 (b)

The dropdown menu that appears when you click the Select Sensor button lists all the connected PowerMax sensors that can be selected for synchronized trending use by the current Front panel.

- **(USB sensors)** The serial numbers of all available attached PowerMax USB sensors are shown in the dropdown menu.
- **(RS sensors)** RS232 sensors will not appear in the dropdown menu because RS232 sensors do not support synchronized data collection.

Notes

- After attaching a sensor, it can take several seconds for the serial number to appear on the list.
- Sensors connected to your computer but already controlled by a Front panel will not appear in the Sensor 2 (b) dropdown list. If you de-select a sensor in a Front panel, the Sensor 2 (b) dropdown list automatically updates and that sensor will then be available for selection.

Synchronization Calculation

Lists the current formula used for math calculation on synchronized data. To change the formula, type the new formula into the **Synchronization Calculation** field—using the letter “a” to reference Sensor 1 and letter “b” to reference Sensor 2. An error dialog will appear if an invalid formula is entered.

Zero Sensor 1 Button

Click the Zero Sensor 1 button to zero the main sensor. Clicking on this button has the same effect as clicking on the main Zero Sensor button.

Zero Sensor 2 Button

Click the Zero Sensor 2 button to zero the second, synchronized sensor.
Large Display Chart

For information about displaying the Large Display Chart in a separate window that can be repositioned, refer to “Show Large Format Display” (p. 3-39).

Graph Palette

Lets you zoom or move the plot displayed in the Trending chart.

Zoom Button

Click this button and then click an option button from the dropdown list to do any of the following actions:
Operation

- Drag the mouse to define the rectangular plot area that will be displayed in the chart.
- Drag the mouse to define the horizontal plot area that will be displayed in the chart.
- Drag the mouse to define the vertical plot area that will be displayed in the chart.
- Click this button to display all data points that have been collected.
- Click this button and then click anywhere on the chart to zoom in.
- Click this button and then click anywhere on the chart to zoom out.

Move Button
Click this button and then drag the mouse on the screen to move the plot in any direction.

(undefined) Button
This button is not used at this time.

Live Reading
Displays the current sensor reading, if Live Data Averaging is set to 1 point. If Live Data Averaging is set to \( n \) points, the Reading indicator displays the average of the last \( n \) points.
Wavelength

The Wavelength field is used to configure the sensor to automatically account for spectral responsivity differences between the laser wavelength and the calibration wavelength. Use this field to enter your laser wavelength.

- Units can be changed by clicking the units dropdown menu (next to the wavelength) and selecting nm or µm.
- If a wavelength outside the permitted range is requested, the nearest minimum value or maximum value will be entered and displayed.

Live Data Averaging

Enables averaging of the last $n$ data points for the power/energy and plot displays. This is computed as a moving average. $n$ can be set from 0-to-60 seconds and 2-to-1000 pulses, depending upon the mode of operation.
Notes:

- Live data averaging is always in points, with 10 points per second in Power mode, and arbitrary points per second in Pulsed Joules mode.
- With optical sensors, live data averaging is always in Power mode with 10 points per second.

**Mean**

Displays the mean of the last $n$ Sample Size samples. The value updates as new samples are acquired. A sample size of 100 will display the stats on two samples, then three, and continue to the $n^{th}$ sample. If the software is in Continuous mode, the statistics will continue to update, using the last $n$ samples. In Fixed mode, the statistics will hold after the $n^{th}$ sample.
**Min**

Displays the minimum value in the last $n$ Sample Size samples. The value updates as new samples are acquired. Example: A sample size of 100 will display the stats on two samples, then three samples, and continue to the $n^{th}$ sample. If the software is in *Continuous* mode, the statistics will continue to update, using the last $n$ samples. In *Fixed* mode, the statistics will hold after the $n^{th}$ sample.

**Counts**

Displays the number of measurements taken in the current data set. Pressing the Reset button resets the counter:

- In *Fixed Sample Collection* mode, the *Counts* field increments until the batch has the number of samples entered in the Sample Size field. At this point, the statistics and the Trending chart will stop updating.

- In *Continuous Sample Collection* mode, the *Counts* field continues incrementing indefinitely as more samples are collected in the batch and plotted in the Trending chart. Even though the *Counts* field continues to increment, the statistics parameters themselves are calculated from the last $n$ number of samples, and the Trending chart displays the last $n$ number of
samples, where \( n \) is the number of samples entered in the Sample Size field.

**Std Dev**

Displays the Standard Deviation of the last \( n \) Sample Size samples. The value updates as new samples are acquired. Example: A sample size of 100 will display the stats on two samples, then three samples, and continue to the \( n^{th} \) sample.

- If the software is in *Continuous* mode, the statistics will continue to update, using the last \( n \) samples.
- In *Fixed* mode, the statistics will hold after the \( n^{th} \) sample.
Max

Displays the maximum value in the last $n$ Sample Size samples. The value updates as new samples are acquired. Example: A sample size of 100 will display the stats on two samples, then three samples, and continue to the $n^{th}$ sample.

- If the software is in Continuous mode, the statistics will continue to update, using the last $n$ samples.
- In Fixed mode, the statistics will hold after the $n^{th}$ sample.

Area

The area entered in this field is used to calculate power density in Watts per square centimeter (W/cm²). The power density reading is displayed in the Live Reading area when Mode is set to Power/cm².
Zero Sensor

Zeroes the PowerMax sensor.

Sample Collection

Selects the logging/plotting mode:

- **Fixed** takes and plots the number of data points shown in the Sample Size and holds the results after the $n^{th}$ sample.
- **Continuous** takes continuous data and plots the number of data points shown in the Sample Size in the chart window. The newest data continuously scrolls in the window.
- The default sample rate for all PowerMax-USB and PowerMax-RS sensors is 10 samples per second. To use a different sample rate, change the Collection Interval.
Mode

Selects the measurement mode: Energy (J), Power (W), Power/dBm, or Power/cm².

- **Energy** refers to a special “long-pulse joules” mode using a thermopile sensor in which the energy in a single long-pulse greater than 1 msec can be integrated by the thermopile sensor to calculate and display the energy in the pulse.

Sample Size

Selects the sample size to collect when in Fixed mode, and the sample size to use for statistics when in either Fixed or Continuous mode. Select **Use Time Base Sample** to change the sample size units to seconds.
Reset

Clicking the Reset button:

- Resets the data set used for statistics (Mean, Min, Max, and Std Dev).
- Resets Counts to 1.
- Clears Trending and other charts.

Reset Error

A separate error dialog window appears when a user action creates an error. This window will list the possible cause of the error, as well as other information. Here is an example:

---

You have to click the OK button in the error dialog window before new commands are accepted.
Gain Correction

Enables/disables Gain Correction.

- Default value: *Off*
- Range: *On* (True), *Off* (False)
- When Gain Correction is enabled, measurements taken by the sensor will be multiplied by the Gain Correction Factor, described below.

Gain Correction Factor

Sets the gain correction factor stored in the PowerMax sensor.

- Default Value: *1.0*
- Range: *0.001* to *100000.0*

The Gain Correction Factor control indicates the current gain correction factor stored in the PowerMax sensor. To change this setting, enter the desired factor into the Gain Correction Factor dialog box. This factor is not applied unless Gain Correction is enabled.
**Operation**

**Collection Mode**

Selects between *Time Interval* (data acquisition on a fixed-time interval) and *Streaming* (continuous data acquisition).

Changing between *Time Interval* and *Streaming* collection modes during data collection automatically clears the data plot display and the statistics batch. Clearing the plot display and statistics batch is done to prevent mixing of data sets with two different time bases. When set to *Streaming*, the collection interval is automatically set to 0.1 seconds.

**Collection Interval**

Sets the collection interval (seconds, minutes, or hours) when Collection Mode is set to *Time Interval*. This control is grayed-out when Collection Mode is set to *Streaming*. 
Log Data to File

Enables/disables saving currently-acquired data to the Log Data file:

- If the Collection mode is *Time Interval*, data is logged to the Log Data file at the interval specified under Collection Interval.
- If the Collection mode is *Streaming*, all data is logged to the Log Data file.

Log Data File

Lists the file currently used to log data. The file is saved in either “csv” (*Comma-Separated Values*) format—which you can automatically open in Excel by double-clicking on the file name—or “txt” format (a standard text file). To view a previously-saved data file, select *View Saved Data File* from the File menu.
Each time you toggle the Log Data to File button, the number added to the file name is automatically incremented to prevent accidentally overwriting of data.

Five dropdown menus appear on the PowerMax PC Front panel: File, Settings, View, Window, and Help. This section describes each of those menus.

Figure 3-2. Dropdown Menus
File Menu

Options available under the File menu:

- View a previously-saved data file (*shortcut: <Ctrl>+<V>*)(this page)
- Open a new Front panel (*shortcut: <Ctrl>+<N>*)(p. 3-32)
- Print the current window (*shortcut: <Ctrl>+<P>*)(p. 3-33)
- Print the current graph or chart (p. 3-33)
- Exit the program (*shortcut: <Ctrl>+<Q>*)(p. 3-33)

View Saved Data File

To view information previously saved in a data file:

1. Click View Saved Data File(*shortcut: <Ctrl>+<V>*)(shortcuts too) from the File dropdown menu:
A menu similar to the following will display:

![Menu Example]

2. Select the name of the file you want to view and then click **Read** to display a chart that has all the saved data. Here is an example chart:

![Chart Example]
Open New Front Panel

The purpose of opening a new Front panel is to control, monitor, and simultaneously log data—from multiple sensors—to separate files. This is good for burn-in stations, where it is necessary to collect data from several lasers at the same time by running several PowerMax sensors on one PC.

A sensor cannot be active in more than one Front panel at a time.

To open a new panel, click Open New Front Panel (shortcut: <Ctrl>+<N>) from the File dropdown menu:

Here is an example of data from two sensors, each displayed within its own Front panel:
Print Window

Selecting Print Window (shortcut: <Ctrl>+<P>) from the File drop-down menu prints the entire active window—including graphs and charts—exactly as it appears on the screen.

Print Graph/Chart

Like the Print Window option, selecting Print Graph/Chart on the File dropdown menu prints the entire active window. This option, however, uses inverted colors to print graphs and charts.

Exit

Selecting the Exit option (shortcut: <Ctrl>+<Q>) on the File dropdown menu closes the PowerMax PC program.
Options available under the Settings menu:

- Turn Speedup on or off (this page)
- Select the log file format (refer to “Log Data File” (p. 3-28) and “Log Data to File” (p. 3-28) for general information about saving data)
- Add a RS232/serial sensor (p. 3-35)
- Disable zero (p. 3-36)

**Speedup**

Selecting or de-selecting Speedup on the Settings dropdown menu controls the host data.

Because of the natural thermal response of thermopile sensors, they have a relatively slow response speed. To make faster measurements with these sensors, use a speedup algorithm while taking power measurements. The Speedup option lets you to turn this algorithm on or off for different functions. The trade off to using Speedup is some loss of accuracy.
Log File Format

Selecting *Log File Format* from the Settings dropdown menu permits the following options to be added or removed from the log file:

- Sensor data
- Calculated (ratio) data
- Position-Sensing Thermopiles: X Position, Y Position
- *(thermopile quad sensors only)* X and Y positions

Add RS232/Serial Sensor

Click *Add RS232/Serial Sensor* from the Settings dropdown menu.

From the Add Serial Sensor screen, select the Com port to which the PowerMax-RS sensor is attached. The Com port number is automatically determined by the computer. (If needed, you can check in Device Manager for available Com ports.) In this example, the selected Com port is 1.
When the Com port is selected, the PowerMax PC software will scan that port and identify the connected sensor. As long as the sensor is correctly connected and powered up, the serial number of the sensor will be available for selection from the dropdown menu in the software. In this example, the connected sensor is **0341I09R**.

**Disable Zero**

The *Disable Zero* function disables the Zero Sensor button in the Front panel. This function prevents accidentally zeroing the sensor during a long-term test.
**View Menu**

Use this menu to select which part of the display is visible.

Options available under the View menu:

- Display the full application view (shortcut: $<\text{Ctrl}>+<F>$) (this page)
- Display the power/energy view only (p. 3-38)
- Display the power/energy and plot view only (p. 3-39)
- Show the large format display (p. 3-39)

![Figure 3-5. View Menu](image)

**Full Application**

![Image of full application view](image)
Example of a Full Application (shortcut: <Ctrl>+<F>) view:

![Full Application View](image)

### Power/Energy

Example of a Power/Energy data view:

![Power/Energy View](image)
Power/Energy and Plot

Example of a Power/Energy and Plot view:

Show Large Format Display

Example of a Show Large Format Display view:
Window Menu

When more than one window is open—that is, when there is more than one sensor connected to the computer and each sensor has its own Front panel open—this menu item lets you determine the relative position of the open Front panels on the monitor screen.

Options available under the Window menu are:

- Tile the windows (this page)
- Cascade the windows (p. 3-41)

Tile Windows

Displays open Front panels edge-to-edge.

If five or more Front panels are open, only the first four panels will tile—the remaining open panels will stay in their current location.

- Cascade Windows: Displays all open Front panels, stacked and cascading from the upper left to the lower right of the screen.
Example of two Front panels in a tiled view:

Cascade Windows
Displays all open Front panels, stacked and cascading from the upper left to the lower right of the screen.

Here’s an example of two Front panels displayed in a cascaded view:
Help Menu

Options available under the Help menu:

- Show context help (this page)
- Display the PowerMax PC help file (p. 3-43)
- Display version and copyright information about PowerMax PC (p. 3-43)

Show Context Help

Opens a separate window that displays information about the screen item currently under the mouse cursor (shortcut: \texttt{<Ctrl>+<H>}).

For example, a screen similar to the following will appear if you select \textit{Show Context Help} and then hover the cursor over the Reset button:
To turn this feature off, either de-select it from the Help dropdown menu, or click the “X” in the top right-hand corner of the Context Help screen.

**PowerMax PC Help**

Displays the software Help file.

**About PowerMax PC**

Displays version and copyright information for the PowerMax PC software.

Here’s an example:
The procedure described in this section works for both PowerMax-RS sensors and PowerMax-USB sensors.

*PowerMax-USB sensors only*: Before using the following procedure, install the PowerMax PC software to make sure the USB driver is correctly installed on the computer. For information on how to add a sensor, refer to “Measuring Power With a PowerMax-USB Thermopile Sensor” (p. 3-4).

1. Open Device Manager on the computer and look for Coherent PowerMax RS or USB Sensor under the Ports (COM & LPT) heading. In the example below, the PowerMax-USB sensor is COM12.

2. Open HyperTerminal (or an equivalent program) and select the port with which you want to communicate.

3. Set the following Com port settings:
   - Baud rate: 9600
   - Data bits: 8
   - Parity: None
   - Stop bits: 1
   - Flow control: None
The following screens are setup examples, specifically for Hyper-Terminal:

HyperTerminal is now available to send and receive basic commands. The following example shows the PW? query and the related response from the PowerMax-USB sensor.
SECTION FIVE: HOST INTERFACE

In this section:
- Introduction (this page)
- Message terminators (p. 5-2)
- Host command quick reference (p. 5-3)
- SCPI interface section (p. 5-5)
- Legacy LaserPAD/SSIM interface section (p. 5-17)
- Data streaming transmission interface gating section (p. 5-22)
- Operational parameters (p. 5-23)
- RS232 port settings (p. 5-24)

Introduction

For those customers who want to communicate with Coherent PowerMax-USB and PowerMax-RS sensors over a host interface—instead of using our PowerMax PC software—we are providing a complete remote host command interface that can be used to control all aspects of sensor operation. You can use this host interface environment to communicate with these sensors in an ad hoc manner using a terminal emulator, or to write custom software in a number of programming environments, including Visual Studio and LabVIEW.

The PowerMax-USB sensors utilize a standard Windows COM class driver and operate much like a serial port. After the driver is installed, the sensor will show up as a device on the computer's COM port and the host interface will accept commands and respond in ASCII format using commands that adhere to the SCPI standard.

The sensors also support a second ASCII command set used by our legacy LaserPAD/SSIM products, which allow drop-in software compatibility. For new software installations, we recommend using the newer SCPI-based command set.

For customers who prefer to capture streaming data over the host port—instead of the query method—we have implemented a special data streaming command interface. This interface requires the user to monitor for a high/low bit—as described under “Data Streaming Transmission Interface Gating Section” (p. 5-22)—and is a more advanced interface than the standard SCPI ASCII command.
language. For customers who want streaming, and who want to stream in a purely ASCII format, there is a command in the legacy LaserPAD/SSIM command set that can be used—refer to “Legacy LaserPAD/SSIM Interface Section” (p. 5-17).

The PowerMax-RS sensors support the same command set as the PowerMax-USB sensors. No driver is required, as they function as a serial device on an RS232 port.

For customers who prefer to program in the National Instruments LabVIEW environment, we provide a full set of LabVIEW drivers on the installation CD that shipped with your system. In addition to a basic Getting Started VI that will show you how to initiate communication with a PowerMax-USB or PowerMax-RS sensor, we also provide access to the architecture of our PowerMax PC software, which was written using our LabVIEW driver library.

**Message Terminators**

Messages between the sensor and the host computer are comprised entirely of ASCII string characters, and all message strings passing through the host interface are terminated to signal the end of a message string.

The one exception to messages comprised entirely of ASCII string characters is the Data Streaming Transmission Interface. After data streaming is initiated, the host sends unsolicited streaming data in non-ASCII format in which a high bit is set on all transmissions. The streaming data mode is covered under “Start Data Streaming Command” and “Stop Data Streaming Command,” beginning on p. 5-21.

**Messages Received by the Sensor**

Messages received by the sensor must be terminated by a carriage return (decimal 13). Line feed characters (decimal 10) are discarded so message terminator flexibility can be attained. A command or query is considered incomplete without the terminator. The maximum length of any message received by the sensor is 200 bytes.

**Messages Sent by the Sensor**

All legacy SSIM messages sent by the sensor—defined under “Legacy LaserPAD/SSIM Interface Section” (p. 5-17)—are terminated by a carriage return.

All other messages sent by the sensor—defined under “SCPI Interface Section” (p. 5-5) and “Data Streaming Transmission Interface Gating Section” (p. 5-22)—are terminated by a carriage return and line feed pair.
The following table gives a brief description of all host commands. For detailed information about a specific command, go to the page referenced in the right-hand column.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
<th>Page #</th>
</tr>
</thead>
<tbody>
<tr>
<td>*RST</td>
<td>Resets all operational parameters to their power-on states.</td>
<td>5-6</td>
</tr>
<tr>
<td>*IDN?</td>
<td>Queries the sensor identification string.</td>
<td>5-6</td>
</tr>
<tr>
<td>SYSTem:STATus?</td>
<td>Queries the system status.</td>
<td>5-6</td>
</tr>
<tr>
<td>SYSTem:INFormation:TEMPerature?</td>
<td>Queries the sensor temperature.</td>
<td>5-7</td>
</tr>
<tr>
<td>SYSTem:SYNC</td>
<td>Resets the system measurement sync timer.</td>
<td>5-7</td>
</tr>
<tr>
<td>SYSTem:SYNC?</td>
<td>Queries the system measurement sync timer.</td>
<td>5-7</td>
</tr>
<tr>
<td>SYSTem:REStore</td>
<td>Restores the persistent data back to the factory settings.</td>
<td>5-7</td>
</tr>
<tr>
<td>SYSTem:COMMunicate:HANDshaking</td>
<td>Selects the state of SCPI message round trip handshaking.</td>
<td>5-7</td>
</tr>
<tr>
<td>SYSTem:COMMunicate:HANDshaking?</td>
<td>Queries the state of SCPI message round trip handshaking.</td>
<td>5-7</td>
</tr>
<tr>
<td>SYSTem:ERRor:COUNt?</td>
<td>Queries the number of error records in the error queue at the time of the query.</td>
<td>5-9</td>
</tr>
<tr>
<td>SYSTem:ERRor:NEXT?</td>
<td>Queries the next error record(s) in the error queue.</td>
<td>5-9</td>
</tr>
<tr>
<td>SYSTem:ERRor:ALL?</td>
<td>Queries all error records in the error queue at the time of the query.</td>
<td>5-9</td>
</tr>
<tr>
<td>SYSTem:ERRor:CLEar</td>
<td>Clears all error records in the error queue.</td>
<td>5-10</td>
</tr>
<tr>
<td>CONFigure:MEASure</td>
<td>Sets the sensor measurement mode.</td>
<td>5-10</td>
</tr>
<tr>
<td>CONFigure:MEASure?</td>
<td>Queries the sensor measurement mode.</td>
<td>5-10</td>
</tr>
<tr>
<td>CONFigure:SPEedup</td>
<td>Sets the speedup state.</td>
<td>5-10</td>
</tr>
<tr>
<td>CONFigure:SPEedup?</td>
<td>Queries the speedup state.</td>
<td>5-10</td>
</tr>
<tr>
<td>CONFigure:WA VElength</td>
<td>Sets the current wavelength.</td>
<td>5-10</td>
</tr>
<tr>
<td>CONFigure:WA VElength?</td>
<td>Queries the current wavelength.</td>
<td>5-10</td>
</tr>
<tr>
<td>CONFigure:GAIN:COMPensation</td>
<td>Enables or disables gain compensation.</td>
<td>5-11</td>
</tr>
<tr>
<td>CONFigure:GAIN:COMPensation?</td>
<td>Queries the state of gain compensation.</td>
<td>5-11</td>
</tr>
<tr>
<td>CONFigure:GAIN:FACTor</td>
<td>Sets the gain compensation factor.</td>
<td>5-11</td>
</tr>
<tr>
<td>CONFigure:GAIN:FACTor?</td>
<td>Queries the gain compensation factor.</td>
<td>5-11</td>
</tr>
<tr>
<td>CONFigure:ZERO</td>
<td>Sets the current measurement as the zero baseline measurement.</td>
<td>5-11</td>
</tr>
<tr>
<td>CONFigure:AMODE</td>
<td>Selects the measurement accuracy mode.</td>
<td>5-11</td>
</tr>
<tr>
<td>TRIGger:PTJ:LEVel</td>
<td>Selects the pulsed thermopile Joules mode trigger sensitivity level.</td>
<td>5-12</td>
</tr>
<tr>
<td>TRIGger:PTJ:LEVel?</td>
<td>Queries the pulsed thermopile Joules mode trigger sensitivity level.</td>
<td>5-12</td>
</tr>
</tbody>
</table>
### Table 5-1. Host Command Quick Reference (Sheet 2 of 2)

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
<th>Page #</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Measurement Data Record Item Select and Format</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONFigure:ITEMselect</td>
<td>Selects the transmit data items</td>
<td>5-12</td>
</tr>
<tr>
<td><strong>Measurement Data Record Reading</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>READ?</td>
<td>Queries the last recorded measurement at the time of the query.</td>
<td>5-14</td>
</tr>
<tr>
<td><strong>Sensor Information</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SYSTem:INFormation:SNUMber?</td>
<td>Queries the serial number.</td>
<td>5-16</td>
</tr>
<tr>
<td>SYSTem:INFormation:PNUMber?</td>
<td>Queries the part number.</td>
<td>5-16</td>
</tr>
<tr>
<td>SYSTem:INFormation:MODEl?</td>
<td>Queries the model name.</td>
<td>5-16</td>
</tr>
<tr>
<td>SYSTem:INFormation:CDATe?</td>
<td>Queries the calibration date.</td>
<td>5-16</td>
</tr>
<tr>
<td>SYSTem:INFormation:MDATe?</td>
<td>Queries the manufacturing date.</td>
<td>5-16</td>
</tr>
<tr>
<td>SYSTem:INFormation:TYPE?</td>
<td>Queries the sensor type and connection configuration.</td>
<td>5-16</td>
</tr>
<tr>
<td>SYSTem:INFormation:DIAMeter?</td>
<td>Queries the aperture diameter.</td>
<td>5-17</td>
</tr>
<tr>
<td>SYSTem:INFormation:WAVElength?</td>
<td>Queries the default wavelength.</td>
<td>5-17</td>
</tr>
<tr>
<td><strong>Legacy LaserPAD/SSIM Interface</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>h</td>
<td>Queries the list of LaserPAD/SSIM commands.</td>
<td>5-17</td>
</tr>
<tr>
<td>*rst</td>
<td>Resets all operational parameters to their power-on states.</td>
<td>5-18</td>
</tr>
<tr>
<td>*ind</td>
<td>Queries the hardware description.</td>
<td>5-18</td>
</tr>
<tr>
<td>v?</td>
<td>Queries the firmware version.</td>
<td>5-18</td>
</tr>
<tr>
<td>vp?</td>
<td>Queries the data stream protocol version.</td>
<td>5-18</td>
</tr>
<tr>
<td>msn?</td>
<td>Queries the serial number.</td>
<td>5-18</td>
</tr>
<tr>
<td>mcal?</td>
<td>Queries the calibration date.</td>
<td>5-19</td>
</tr>
<tr>
<td>mfg</td>
<td>Queries the manufacturing date.</td>
<td>5-19</td>
</tr>
<tr>
<td>df?</td>
<td>Queries the sensor family.</td>
<td>5-19</td>
</tr>
<tr>
<td>app</td>
<td>Queries the aperture diameter.</td>
<td>5-19</td>
</tr>
<tr>
<td>rmi</td>
<td>Queries the minimum range.</td>
<td>5-19</td>
</tr>
<tr>
<td>rmx</td>
<td>Queries the maximum range.</td>
<td>5-19</td>
</tr>
<tr>
<td>spd?</td>
<td>Queries the speedup state.</td>
<td>5-19</td>
</tr>
<tr>
<td>spd</td>
<td>Toggles the speedup state.</td>
<td>5-20</td>
</tr>
<tr>
<td>wl?</td>
<td>Queries the default wavelength.</td>
<td>5-20</td>
</tr>
<tr>
<td>wv?</td>
<td>Queries the current wavelength.</td>
<td>5-20</td>
</tr>
<tr>
<td>wv</td>
<td>Sets the current wavelength.</td>
<td>5-20</td>
</tr>
<tr>
<td>pw?</td>
<td>Queries the current power reading.</td>
<td>5-20</td>
</tr>
<tr>
<td>pos</td>
<td>Queries the current beam position.</td>
<td>5-20</td>
</tr>
<tr>
<td>tmp</td>
<td>Queries the current thermistor ADC value.</td>
<td>5-21</td>
</tr>
<tr>
<td>dst</td>
<td>Enables LaserPAD/SSIM interface data streaming.</td>
<td>5-21</td>
</tr>
<tr>
<td>dsp</td>
<td>Disables LaserPAD/SSIM interface data streaming.</td>
<td>5-21</td>
</tr>
<tr>
<td><strong>Data Streaming Transmission Interface Gating</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>INITiate</td>
<td>Enables data streaming interface transmission.</td>
<td>5-22</td>
</tr>
<tr>
<td>ABORt</td>
<td>Disables data streaming interface transmission.</td>
<td>5-22</td>
</tr>
</tbody>
</table>
SCPI Interface
Section

Syntax and Notation Conventions

Unless otherwise specified, all SCPI commands and queries follow the syntax and notation conventions specified by the SCPI Standard. For more information, refer to the SCPI Standard—found on the IVI Foundation website.

All commands must end with a carriage return character. A carriage return character instructs the meter that the full command has been received.

The base-10 numeric data format specification is used heavily in this document. Unless otherwise specified, numeric data items are represented as:

- integer values
- non-scientific notation floating point values
- scientific notation floating point values (upper or lower case E)

For example, the following data values are functionally equivalent:

- 31256
- 31256.0
- 3.1256E4
- 31.256E3
- +3.1256E+4.

Unless otherwise specified, non-numeric data items (typically referred to as strings) are not quoted.

Enumerated values must exactly match, using the long form/short form comparison rules defined under the SCPI Standard.
Commands and Queries

SCPI Common Commands

The SCPI Standard specifies a standard set of common commands. All common commands and queries start with an asterisk.

**Reset Command - *RST**

Resets all operational parameters to their power-on states. Reset does not affect factory settings. Also see “Reset Command - *RST” (p. 5-6).

Command: *RST

Query: none

**Identification Query - *IDN?**

Queries the sensor identification string, such as model name, firmware version, and firmware date.

Query: *IDN?

Reply: “Coherent, Inc – PowerMax” + <type> + “–” + <version> + “–” + <firmware date> *Note: The quotes are not transmitted.*


System Options

The system commands and queries access functionality that is exclusive of sensor measurement functions. These commands can be sent at any time without affecting a measurement in progress.

**System Status**

Queries the system status. Status is returned in a string containing one ASCII character for each status condition that is asserted. If the status condition character is present, the condition is asserted. If the status condition character is absent, the condition is not asserted. The following table describes the status condition character mapping.

<table>
<thead>
<tr>
<th>Status Character</th>
<th>Status Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>T</td>
<td>Damage temperature is exceeded</td>
</tr>
<tr>
<td>0 (zero)</td>
<td>No status condition is asserted</td>
</tr>
</tbody>
</table>

Command: none
Query: SYSTem:STATus?
Reply: <status>

Example: If the sensor damage temperature is exceeded, the system status query will return:

“T” note: The quotes are not transmitted.

**Sensor Temperature**

Queries the sensor temperature.

Command: none

Query: SYSTem:INFormation:TEMPerature?
Reply: <sensor temperature in degrees Celsius in integer format>

The literal string “NA” (quotes not included) is returned if the sensor does not have a temperature measurement capability.

**System Sync**

Resets the system measurement sync timer. This query gets the system measurement sync timer value. The system measurement sync timer is a free-running timer that increments by one for every 1 millisecond of elapsed time. It is necessary to synchronize the measurement sync timers of all sensors that are used for applications requiring synchronization. The maximum value of this timer is 4294967295 milliseconds; however, to counteract clock creep, the system sync command should be sent at intervals not to exceed 10 minutes.

Command: SYSTem:SYNC

Query: SYSTem:SYNC?
Reply: <current timer value>

**System Restore**

Restores the persistent data back to the factory settings, which erases user-defined settings.

Command: SYSTem:RESTore

Query: none

**Message Handshaking**

Selects the state of SCPI message round trip handshaking.

Command: SYSTem:COMMunicate:HANDshaking {ON|OFF}
Reply: OK if ON is selected; otherwise, no reply is sent

Default is OFF.
Query: SYSTem:COMMunicate:HANDshaking?
Reply: ON|OFF

If handshaking is ON:

- Empty commands (commands with only whitespace characters) reply with “OK\r\n”
- Valid commands with valid data reply with “OK\r\n”
- Valid queries with valid data reply as explicitly defined elsewhere in this section, followed by “OK\r\n”
- Valid commands or queries which result in an error reply with “ERR<n>\r\n”, where <n> is the error code number—see “Error Record Reporting and Collection” (p. 5-8).
- Unrecognized commands or queries reply with “ERR100\r\n”
- Error queuing occurs, as explicitly defined elsewhere in this document

If handshaking is OFF:

- All command and query response will behave as explicitly defined elsewhere in this section

---

**Error Record Reporting and Collection**

Programming and system errors occasionally occur while testing or debugging remote programs, and during measurement. Error strings follow the SCPI Standard for error record definition:

<error code>,<quoted error string>

The host queries for errors in two steps:

1. The host queries for the number of error records available (N).
2. The host queries N times for the error records.

Errors are stacked up to 20 deep. In the case of error overflow, the last error in the error list is an indication of error overflow.

The possible error strings are shown in the following table.

<table>
<thead>
<tr>
<th>Error Code Number</th>
<th>Quoted Error String</th>
<th>Error Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-350</td>
<td>“Queue overflow”</td>
<td>Error queue is full</td>
</tr>
<tr>
<td>-310</td>
<td>“System error”</td>
<td>Unexpected/unrecoverable hardware or software fault</td>
</tr>
<tr>
<td>0</td>
<td>“No error”</td>
<td>No error</td>
</tr>
<tr>
<td>100</td>
<td>“Unrecognized command/query”</td>
<td>The command or query is not recognized</td>
</tr>
<tr>
<td>101</td>
<td>“Invalid parameter”</td>
<td>The command or query parameter is invalid</td>
</tr>
<tr>
<td>102</td>
<td>“Data error”</td>
<td>A data error was encountered</td>
</tr>
</tbody>
</table>
Error -350 is raised when the error queue becomes full. Non-“Queue overflow” errors are replaced by “Queue overflow” errors when there is exactly one available storage location available in the error queue. No additional errors are added to the error queue if the error queue is full.

Error -310 is raised when the firmware detects an unexpected or unrecoverable error. This error condition includes unrecoverable hardware faults.

Error 100 is raised when the sensor receives an unrecognized command or query.

Error 101 is raised when the sensor receives a command or query with one or more invalid data parameters.

Error 102 is raised when the sensor receives a command or query for which no valid data exists.

**Error Count Query**

Queries the number of error records in the error queue at the time of the query.

Command: none

Query: SYSTem:ERRor:COUNt?
Reply: <count of error records stored in integer format>

**Error Query**

Queries the next error record(s) in the error queue. More than one error record may be queried using the optional <error record count> parameter, which must be an integer value. A single error record is returned if <error record count> is not specified. No reply is transmitted if no error records are available.

As the sensor transmits each error record:

- The error record is permanently removed from the error queue
- The queued error record count decrements by one

Command: none

Query: SYSTem:ERRor:NEXT? [<error record count>]
Default is not applicable.
Reply: <next available error record(s)>

**All Error Query**

Queries all error records in the error queue at the time of the query. No reply is transmitted if there are no error records available.

After completion of the reply transmission:
• The error queue will be empty
• The queued error record count will be zero

Command: none
Query: SYSTem:ERRor:ALL?
Reply: <all available error record(s)>

**All Error Clear**

Clears all error records in the error queue.

Command: SYSTem:ERRor:CLEar
Query: none

### Measurement Setup and Control

#### Measurement Mode

Sets the sensor measurement mode to select either power (Watts) or energy (Joules) measurement mode. Note: Joules measurement mode is only possible with a thermopile type power sensor.

Command: CONFigure:MEASure {DEFault|J|W}
Default is W (Watts) mode.

Query: CONFigure:MEASure?
Reply: J|W

*Error 100 is raised if the sensor is an optical sensor.*

#### Speedup

Sets the speedup state. The query gets the speedup state.

Command: CONFigure:SPEedup {DEFault|ON|OFF}
Default is OFF

Query: CONFigure:SPEedup?
Reply: {ON|OFF}

*Error 100 is raised if the sensor is an optical sensor.*

#### Wavelength

Sets the current wavelength, which is committed to persistent storage when it is changed. If the requested wavelength is *greater* than the upper wavelength limit, the current wavelength is set to the upper wavelength limit. Likewise, if the requested wavelength is *less* than the lower wavelength limit, the current wavelength is set to the lower wavelength limit. The minimum and maximum allowed wavelength may also be named as data arguments. The query gets the current maximum or minimum allowed wavelengths, depending on the optional query data argument.
Host Interface

**Command:** CONFigure:WAVElength {MINimum|MAXimum|<requested wavelength in nm>}

**Query:** CONFigure:WAVElength? [MINimum|MAXimum]

**Reply (if [MINimum|MAXimum] is not specified):**
<granted wavelength in nm>

**Reply (if MAXimum is specified):**
<allowed maximum wavelength in nm>

**Reply (if MINimum is specified):**
<allowed minimum wavelength in nm>

---

**Gain Compensation**

**Enable/Disable State**

Enables or disables gain compensation, which is committed to persistent storage when it is changed. If gain compensation is enabled, power readings sent over the host port will be measured power multiplied by the gain compensation factor.

**Command:** CONFigure:GAIN:COMPensation {DEFault|OFF|ON}

Default is OFF

**Query:** CONFigure:GAIN:COMPensation?

Reply: OFF|ON

**Factor**

Sets the gain compensation factor, which is committed to persistent storage when it is changed.

**Command:** CONFigure:GAIN:FACTor {DEFault|<0.001..100000.0>}

Default is 1.0

**Query:** CONFigure:GAIN:FACTor?

Reply: <gain compensation factor>

---

**Sensor Zero**

Sets the current measurement as the zero baseline measurement. We recommend that you zero the sensor prior to measuring power to null out any offset in the power sensor. If you have recently touched a thermopile or exposed it to heat, you must wait for the sensor to settle back to a stable zero point before sending the Zero command.

**Command:** CONFigure:ZERO

---

**Accuracy Mode**

Selects the measurement accuracy mode. The available modes are power-only and power-plus-position.
Command: CONFigure:AMODe {DEFault|PONly|PPPosition}
Default is PPPosition (power plus position) mode

Query: CONFigure:AMODe?
Reply: PONLY|PPPOSITION

Error 100 is raised if the sensor is a mono or optical sensor.

**Pulsed Thermopile Joules Trigger Level**

Selects the pulsed thermopile Joules mode trigger sensitivity level.

Command: TRIGger:PTJ:LEVel {DEFault|LOW|MEDium|HIGH}
Default is LOW

Query: TRIGger:PTJ:LEVel?
Reply: LOW|MEDIUM|HIGH

---

**Measurement Data Record Item Select and Format**

Data items that appear in a measurement data record are selectable. Available selections differ, based on measurement mode and sensor type.

This command selects the transmit data items transmitted in non-SIMM measurement data records—defined later in this section, and SSIM measurement data records—defined under “LaserPAD/SSIM Streaming Data Record Format” (p. 5-21). The data argument is a comma-separated list of one or more tokens, shown below. At least one token must be specified. The tokens may be specified in any order.

Command: CONFigure:ITEMselect {MEAS,POS,FLAG,TST}
Query: CONFigure:ITEMselect?
Reply: one or more of MEAS|POS|FLAG|TST

Measurement data records contain one or more data items and are formatted according to the following table.

*Table 5-4. Non-SIMM Measurement Data Record Formats*

<table>
<thead>
<tr>
<th>Sensor Type</th>
<th>Measurement Mode</th>
<th>Last Measurement Record Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thermopile Mono</td>
<td>Watts</td>
<td>&lt;power&gt;,&lt;flags&gt;,&lt;timestamp&gt;</td>
</tr>
<tr>
<td></td>
<td>Joules</td>
<td>&lt;energy&gt;,&lt;flags&gt;,&lt;timestamp&gt;</td>
</tr>
<tr>
<td>Thermopile Quad</td>
<td>Watts</td>
<td>&lt;power&gt;,&lt;X position&gt;,&lt;Y position&gt;,&lt;flags&gt;,&lt;timestamp&gt;</td>
</tr>
<tr>
<td></td>
<td>Joules</td>
<td>&lt;energy&gt;,&lt;flags&gt;,&lt;timestamp&gt;</td>
</tr>
<tr>
<td>Optical</td>
<td>Watts</td>
<td>&lt;power&gt;,&lt;flags&gt;,&lt;timestamp&gt;</td>
</tr>
</tbody>
</table>
Each data item is selected for transmission using the ITEMselect command:

- `<power>`, expressed in Watts using the “%.5E” C formatting specification, is transmitted when MEAS is specified
- `<energy>`, expressed in Joules using the “%.5E” C formatting specification, is transmitted when MEAS is specified
- `<X position>` and `<Y position>`, expressed in mm using the “%.2E” C formatting specification, is transmitted when POS is specified
- `<flags>`, enumerated in Table 5 and described below, is transmitted when FLAG is specified
- `<timestamp>`, expressed in integer milliseconds, is transmitted when TST is specified

The `<flags>` data item, which communicates qualification information, is reported with each data message. Qualification information includes various error conditions. It is reported in a string containing one ASCII character for each qualification that is asserted. If the qualification character is present, the qualification is asserted. If the qualification condition character is absent, the qualification is not asserted. Each character present has a unique meaning as described in the following table.

<table>
<thead>
<tr>
<th>Qualification Character</th>
<th>Qualification Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>R</td>
<td>Over-range error</td>
</tr>
<tr>
<td>N</td>
<td>Negative power</td>
</tr>
<tr>
<td>S</td>
<td>Measurement is sped up</td>
</tr>
<tr>
<td>T</td>
<td>Over-temperature error</td>
</tr>
<tr>
<td>0 (zero)</td>
<td>No qualification exists</td>
</tr>
</tbody>
</table>

Selecting POS for non-quad sensors has no effect on the transmission of data records.

X and Y positions are zero if the power is less than 10% of the minimum range—refer to “Minimum Range Query” (p. 5-19).

The data has over-range status if the power is greater than the maximum range—refer to “Maximum Range Query” (p. 5-19).
Measurement Data Record Reading

Queries the last recorded measurement at the time of the query. No reply is transmitted if a measurement has not been recorded.

Command: none

Query: READ?
Reply: <last measurement record>

The last measurement record is composed of comma-delimited data items generated at the same instant. The data items presented, including a flags item, varies, depending on the sensor type as enumerated in the following table.

<table>
<thead>
<tr>
<th>Sensor Type</th>
<th>Measurement Mode</th>
<th>Last Measurement Record Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thermopile Mono</td>
<td>Watts</td>
<td>&lt;power&gt;,&lt;flags&gt;,&lt;timestamp&gt;</td>
</tr>
<tr>
<td></td>
<td>Joules</td>
<td>&lt;energy&gt;,&lt;flags&gt;,&lt;timestamp&gt;</td>
</tr>
<tr>
<td>Thermopile Quad</td>
<td>Watts</td>
<td>&lt;power&gt;,&lt;X position&gt;,&lt;Y position&gt;,&lt;flags&gt;,&lt;timestamp&gt;</td>
</tr>
<tr>
<td></td>
<td>Joules</td>
<td>&lt;energy&gt;,&lt;flags&gt;,&lt;timestamp&gt;</td>
</tr>
<tr>
<td>Optical</td>
<td>Watts</td>
<td>&lt;power&gt;,&lt;flags&gt;,&lt;timestamp&gt;</td>
</tr>
</tbody>
</table>

<power> will be expressed in Watts using the “%.5E” C formatting specification.

<energy> will be expressed in Joules using the “%.5E” C formatting specification.

<X position> and <Y position> will be expressed in mm using the “%.2E” C formatting specification.

<timestamp> will be expressed in integer milliseconds. This timestamp is based upon the system sync function. Zero time is set when the device receives the SYSTem:SYNC command.

The <flags> data item, which communicates qualification information, is reported with each data message. Qualification information—including various error conditions—is reported in a string containing one ASCII character for each qualification that is asserted. If the qualification character is present, the qualification is asserted. If the qualification condition character is absent, the qualification is not asserted. Each character present has a unique meaning, as described in the following table.
Host Interface

Table 5-7. Flags Character Definitions

<table>
<thead>
<tr>
<th>Qualification Character</th>
<th>Qualification Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>R</td>
<td>Over-range error</td>
</tr>
<tr>
<td>N</td>
<td>Negative power</td>
</tr>
<tr>
<td>S</td>
<td>Measurement is sped up</td>
</tr>
<tr>
<td>T</td>
<td>Over-temperature error</td>
</tr>
<tr>
<td>0 (zero)</td>
<td>No qualification exists</td>
</tr>
</tbody>
</table>

- X and Y positions are zero if the power is less than 10% of the minimum range.
- Data has over-range status if the power is greater than the maximum range.

The READ? query returns a power reading, along with a flag and a timestamp. The power reading is in the format of \( X.XXX \), followed by an exponent value. In the following example, two readings were taken:

![Power reading screenshot](image)

- The first power reading return is \(-1.53175e-03\), followed by the \( N \) flag (indicating a negative power reading—meaning the sensor has not yet been properly zeroed), and then the timestamp (47300 ms).
- The second power reading return is \(-2.05320e-03\), followed by the \( N \) flag and the timestamp (53700 ms).

The READ? query separates the reading into several parts. If only a numeric value for a power reading is needed, use the PW? query, which is easier to use if you want a power reading and aren't worried about checking for errors or a timestamp. For more information about the PW? query, refer to “Current Power Reading Query” (p. 5-20).
Sensor Information

The sensor can be queried for unit identification and quality control information.

Serial Number

The query gets the sensor serial number.
Query: SYSTem:INFormation:SNUMber?
Reply: <quoted serial number>

Part Number

The query gets the part number.
Query: SYSTem:INFormation:PNUMber?
Reply: <quoted part number>

Model Name

The query gets the model name.
Query: SYSTem:INFormation:MODel?
Reply: <quoted model name>

Calibration Date

The query gets the calibration date.
Query: SYSTem:INFormation:CDATe?
Reply: <quoted calibration date>

Manufacturing Date

The query gets the manufacturing date.
Query: SYSTem:INFormation:MDATe?
Reply: <quoted calibration date>

Sensor Type and Connection Configuration

The query gets the sensor type and connection configuration (thermopile mono, thermopile classical quad, thermopile enhanced quad, or optical).
Query: SYSTem:INFormation:TYPE?
Reply: <type>,<qualifier>

<type> is one of THERMO or OPT.
<qualifier> is one of SINGLE, QUAD, ENHQUAD, or NOSPEC.
Aperture Diameter

The query gets the aperture diameter.

Query: SYSTem:INFormation:DIAMeter?
Reply: <aperture diameter in mm>

Default Wavelength

The query gets the default wavelength.

Query: SYSTem:INFormation:WA VElength?
Reply: <default wavelength in nm>

Legacy LaserPAD/SSIM Interface Section

PowerMax-USB and PowerMax-RS sensors support the legacy LaserPAD/SSIM host command sets. This offers customers the capability of using PowerMax-USB and PowerMax-RS sensors as drop-in replacements for their current OEM sensors. The LaserPAD/SSIM interface supports all LaserPAD/SSIM commands, queries, and responses, except those related to PocketPC mode.

Note that some LaserPAD/SSIM commands also have defined replies.

Help Query

Queries the list of LaserPAD/SSIM commands.

Query: h
Reply:

```
"*rst - reset system
*ind - identify system
app - get aperture diameter
cal - get calibration date
df? - get family
dsp - stop data streaming
dst - start data streaming
dt? - get name
h - show this help
mfg - get manufacture date
pos - get x,y position in mm
pw? - get power in watts
rmi - get minimum range
rmx - get maximum range
sn? - get serial number
tmp - get thermistor reading
v? - get firmware version
vp? - get protocol version
```
wl? - get default wavelength
wv <float> - set current wavelength in meters
wv? - get current wavelength in meters
spd - toggles speedup state on/off
spd? - queries the speedup state” Note: The quotes are not transmitted.

Reset Command
Resets all operational parameters to their power-on states. Reset does not affect factory settings. Also refer to “Reset Command - *RST” (p. 5-6).

Command: *rst
Reply: none

Hardware Description Query
Queries the hardware description.

Query: *ind
Alias query: dt?
Reply: “PowerMax” + <type> Note: The quotes are not transmitted.
Example reply: PowerMax USB

Firmware Version Query
Queries the firmware version.

Query: v?
Reply: <the firmware version string>

Data Stream Protocol Version Query
Queries the data stream protocol version.

Query: vp?
Reply: “v.12.10.03” Note: The quotes are not transmitted.

Serial Number Query
Queries the serial number.

Query: msn?
Alias query: sn?
Reply: <serial number>
**Host Interface**

**Calibration Date Query**
Queries the calibration date.
Query: mcal?
Alias queries: cal and cal?
Reply: <calibration date>

**Manufacturing Date Query**
Queries the manufacturing date.
Query: mfg
Alias query: mmfg?
Reply: <manufacturing date>

**Sensor Family Query**
Queries the sensor family.
Query: df?
Reply: {“thermal”|“quantum”} Note: The quotes are not transmitted.

**Aperture Diameter Query**
Queries the aperture diameter, a fixed value.
Query: app
Reply: <aperture diameter in mm>

**Minimum Range Query**
Queries the minimum range.
Query: rmi
Reply: <minimum allowed power measurement in watts>

**Maximum Range Query**
Queries the maximum range.
Query: rmx
Reply: <maximum allowed power measurement in watts>

**Speedup State Query**
Queries the speedup state.
Query: spd?
Reply: {“on”|“off”} Note: The quotes are not transmitted.
Speedup State Toggle Command
Toggles the speedup state. If the speedup state is ON, sending the command turns speedup OFF, and vice versa.

Command: spd
Reply: {“speedup threshholding is on.”|“speedup threshholding is off.”} Note: The quotes are not transmitted.

Default Wavelength Query
Queries the default wavelength.
Query: wl?
Reply: <default wavelength in meters>

Current Wavelength Query
Queries the current wavelength.
Query: wv?
Reply: <current wavelength in meters>

Current Wavelength Command
Sets the current wavelength, which is committed to persistent storage when it is changed. If the requested wavelength is greater than the upper wavelength limit, the requested wavelength is set to the upper wavelength limit. Likewise, if the requested wavelength is less than the lower wavelength limit, the requested wavelength is set to the lower wavelength limit.

Command: wv <requested wavelength in meters>
Reply: <granted wavelength in meters>

Current Power Reading Query
Queries the current power reading.
Query: pw?
Reply: <current power reading in watts>

Current Beam Position Query
Queries the current beam position. If the sensor is an optical sensor, the returned position X and Y values are 0.
Query: pos
Reply (thermopile quad sensor): <X position in mm>,<Y position in mm>
Reply (thermopile mono or optical sensor): 0,0
Note that X and Y positions are zero if the sensor is a thermopile mono or if the power is less than 10% of the minimum range—see “Minimum Range Query” (p. 5-19).

**Current Thermistor Counts Query**
Queries the current thermistor ADC value.

Query: tmp
Reply: <thermistor integer ADC counts>

**Start Data Streaming Command**
Enables LaserPAD/SSIM mode interface data streaming. Streaming data records are transmitted at 10 Hz. Streaming data records continue to be transmitted until the Stop Data Streaming command (see below) is issued.

Command: dst
Reply: none

**Stop Data Streaming Command**
Disables LaserPAD/SSIM mode interface data streaming.

Command: dsp
Reply: none

---

**LaserPAD/SSIM Streaming Data Record Format**
The LaserPAD/SSIM mode streaming data record format is different for thermopile and optical sensors, as shown in the following table.

<table>
<thead>
<tr>
<th>Sensor Type</th>
<th>Last Measurement Record Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thermopile</td>
<td>*&lt;X position in mm&gt;,&lt;Y position in mm&gt;,&lt;power in Watts&gt;,&lt;status code&gt;</td>
</tr>
<tr>
<td>Optical</td>
<td>*&lt;power in Watts&gt;,&lt;status code&gt;</td>
</tr>
</tbody>
</table>

The asterisk is literal.

X and Y position are zero if the sensor is a thermopile mono or if the power is less than 10% of the minimum range—see “Minimum Range Query” (p. 5-19).

The data has over-range status if the power is greater than the maximum range—see “Maximum Range Query” (p. 5-19).

Each data item is selected for transmission using the ITEMselect command—see “Measurement Data Record Item Select and Format” (p. 5-12):
• <power in Watts>, expressed in Watts using the “%.3e” C formatting specification, is transmitted when MEAS is specified
• <X position in mm> and <Y position in mm>, expressed in mm using the “%.2e” C formatting specification, is transmitted when POS is specified
• <status code> (described below) is transmitted when FLAG is specified

Status code:
c = Measurement data is valid
r = Measurement is over-range
t = Sensor temperature exceeds the damage temperature

Data Streaming Transmission Interface Gating Section

The data streaming transmission interface should not be confused with legacy LaserPAD/SSIM mode interface data streaming. Gating of the data streaming transmission is controlled by the INITiate and ABORt commands (described under “Initiate Command” and “Abort Command,” below).

Streaming Measurement Data

In data streaming mode, the host has control over when measurement data is transmitted from the data streaming transmission interface. Transmission is enabled after an INITiate command and disabled after an ABORt command. When transmission is enabled, measurement data records are transmitted immediately as they are generated.

Commands and Queries

Initiate Command
Enables data streaming interface transmission. This command is ignored if data streaming interface transmission is already enabled.

Command: INITiate
Query: none

Abort Command
Disables data streaming interface transmission. This command is ignored if data streaming interface transmission is already disabled.

Command: ABORt
Query: none
Host Interface

Data streaming transmission messages are ASCII formatted, but not strictly so. The high bit (mask 0x80) is always set for all bytes of all data streaming transmission messages, including the terminators. This allows host software to easily differentiate between data streaming transmission messages and LaserPAD/SSIM and SCPI reply messages. The host may operate using the rule that if the high bit is set on any byte received from the sensor, it is part of a data streaming transmission message.

Data streaming transmission messages are immediately sent to the host in ASCII text form as measurements are generated (see Table 5-9, below). Each message conforms to the last measurement data record format but with the high bit set in all transmitted bytes.

### Table 5-9. Data Streaming Transmission Rates

<table>
<thead>
<tr>
<th>Sensor Type</th>
<th>Measurement Mode</th>
<th>Transmission Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thermopile</td>
<td>Watts</td>
<td>Continuously at 10 Hz</td>
</tr>
<tr>
<td>Thermopile</td>
<td>Joules</td>
<td>When pulse energy is calculated</td>
</tr>
<tr>
<td>Optical</td>
<td>Watts</td>
<td>Continuously at 10 Hz</td>
</tr>
</tbody>
</table>

Operational Parameters

All operational parameters—except the current wavelength, gain compensation factor, and gain compensation state—are not persistent after a reset cycle. The following table shows all operational parameters.

### Table 5-10. Operational Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Power-on State</th>
</tr>
</thead>
<tbody>
<tr>
<td>Speedup state</td>
<td>Off</td>
</tr>
<tr>
<td>Measure Mode</td>
<td>Watts</td>
</tr>
<tr>
<td>Error count</td>
<td>0</td>
</tr>
<tr>
<td>LaserPAD/SSIM data streaming state</td>
<td>Stopped/Disabled</td>
</tr>
<tr>
<td>Data streaming transmission interface state</td>
<td>Stopped/Disabled</td>
</tr>
<tr>
<td>Sync</td>
<td>0</td>
</tr>
<tr>
<td>SCPI handshaking</td>
<td>Off</td>
</tr>
<tr>
<td>Zero</td>
<td>Factory setting</td>
</tr>
<tr>
<td>Pulsed thermopile Joules mode trigger sensitivity level</td>
<td>Low</td>
</tr>
<tr>
<td>Accuracy mode</td>
<td>Power-plus-position</td>
</tr>
<tr>
<td>Current wavelength (persistent)</td>
<td>Last granted setting</td>
</tr>
<tr>
<td>Gain compensation factor (persistent)</td>
<td>Last setting</td>
</tr>
<tr>
<td>Gain compensation state (persistent)</td>
<td>Last setting</td>
</tr>
<tr>
<td>Wavelength correction cursor</td>
<td>0/start</td>
</tr>
<tr>
<td>Temperature compensation cursor</td>
<td>0/start</td>
</tr>
<tr>
<td>Power compensation cursor</td>
<td>0/start</td>
</tr>
</tbody>
</table>
RS232 Port Settings

The PowerMax-RS sensors communicate over an RS232 port using the RS232 settings shown in the following table.

Table 5-11. RS232 Port Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Baud rate</td>
<td>9600</td>
</tr>
<tr>
<td>Data bits</td>
<td>8</td>
</tr>
<tr>
<td>Parity</td>
<td>None</td>
</tr>
<tr>
<td>Stop bits</td>
<td>1</td>
</tr>
<tr>
<td>Flow control</td>
<td>None</td>
</tr>
</tbody>
</table>
SECTION SIX: CALIBRATION AND WARRANTY

In this section:

- Calibration (this page)
- Coherent calibration facilities and capabilities (this page)
- Limited warranty (p. 6-2)
- Extended warranty (p. 6-2)
- Warranty limitations (p. 6-3)
- Obtaining service (p. 6-3)
- Product shipping instructions (p. 6-4)

**Calibration**

Coherent laser power and energy meters are precision instruments, capable of delivering very accurate measurements, as well as providing many years of useful service. To maintain this high level of performance, it is important to have your measurement system serviced and recalibrated once a year.

**Coherent Calibration Facilities and Capabilities**

As the largest laser manufacturer in the world, Coherent has been able to build state-of-the-art calibration facilities containing the widest possible range of laser types and technologies. This enables us to perform instrument and sensor calibration under virtually any combination of wavelength, power, and operating characteristics. Sensors are calibrated against NIST-traceable working standards which, in turn, are calibrated against NIST-calibrated golden standards. These working and golden standards are maintained with the utmost care, recalibrated annually, and verified even more regularly. We maintain multiple NIST-calibrated standards at many laser wavelengths to support the growing calibration needs of our customers. Optical calibration is a core competency at Coherent and we strive to continually improve our methods, precision, and repeatability. Additionally, most of the calibrations are performed with highly automated systems, thus reducing the possibility of human error to nearly zero. Strict quality inspections during many stages of calibration and testing assure a precise and accurate instrument that is NIST traceable and CE marked. The benefit to our customers is that instruments calibrated by Coherent will consis-
tently perform as expected under their actual use conditions. We are a registered ISO 9001:2000 company, our products are NIST trace-
able, and our calibration labs are fully ANSI Z540 compliant.

In addition to the technological advantage, we also strive to deliver the best service in the industry, with a knowledgeable and responsive staff, and rapid turnaround.

**Limited Warranty**

Coherent, Inc. (the “Company”) warrants its laser power and energy meters and sensors products (“Products”) to the original purchaser (the “Customer”) that the product is free from defects in materials and workmanship and complies with all specifications, active at the time of purchase, for a period of twelve (12) months.

Coherent, Inc. will, at its option, repair or replace any product or component found to be defective during the warranty period. This warranty applies only to the original purchaser and is not transferable.

**Extended Warranty**

Coherent, Inc. (the “Company”) offers original purchasers (the “Customer”) purchasing laser power and energy meters and sensors products (“Products”) an extended twelve (12) month warranty program, which includes all parts and labor. In order to qualify for this warranty, a Customer must return the Product to the Company for recalibration and recertification. The Company will re-certify the Product, provide software upgrades, and perform any needed repairs, and recalibrate the Product, for a fixed service fee (as established by the Company from time to time and in effect at the time of service). If the product cannot be re-certified due to damage beyond repair, parts obsolescence, or other reasons, the Customer may be informed that an Extended Warranty program is not available for the Product.

If the Product fails and is returned to the Company within one year following the date of recalibration and recertification service, the Company will, at its option, repair or replace the Product or any component found to be defective. If the Product must be replaced and the Product is no longer available for sale, Coherent reserves the right to replace with an equivalent or better Product. This warranty applies only to the original purchaser and is not transferable.
**Warranty Limitations**

The foregoing warranties shall not apply, and Coherent reserves the right to refuse warranty service, should malfunction or failure result from:

- Damage caused by improper installation, handling or use.
- Laser damage (including sensor elements damaged beyond repair).
- Failure to follow recommended maintenance procedures.
- Unauthorized product modification or repair.
- Operation outside the environmental specifications of the product.

Coherent assumes no liability for Customer-supplied material returned with Products for warranty service or recalibration.

**THIS WARRANTY IS EXCLUSIVE IN LIEU OF ALL OTHER WARRANTIES WHETHER WRITTEN, ORAL, OR IMPLIED. COHERENT SPECIFICALLY DISCLAIMS THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT SHALL THE COMPANY BE LIABLE FOR ANY INDIRECT, INCIDENTAL OR CONSEQUENTIAL DAMAGES IN CONNECTION WITH ITS PRODUCTS.**

**Obtaining Service**

In order to obtain service under this warranty, Customer must notify the Company of the defect before the expiration of the warranty period and make suitable arrangements for the performance of service. The Company shall, in its sole discretion, determine whether to perform warranty service at the Customer's facility, at the Company's facility or at an authorized repair station.

If Customer is directed by the Company to ship the product to the Company or a repair station, Customer shall package the product (to protect from damage during shipping) and ship it to the address specified by the Company, shipping prepaid. The customer shall pay the cost of shipping the Product back to the Customer in conjunction with recalibration and recertification; the Company shall pay the cost of shipping the Product back to the Customer in conjunction with product failures within the first twelve months of time of sale or during an extended twelve month warranty period.

A Returned Material Authorization number (RMA) assigned by the Company must be included on the outside of all shipping packages and containers. Items returned without an RMA number are subject to return to the sender.
To prepare the product for shipping to Coherent:

1. Contact Coherent Customer Service (refer to Table 6-1, above) for a Return Material Authorization number.

2. Attach a tag to the product that includes the name and address of the owner, the person to contact, the serial number, and the RMA number you received from Coherent Customer Service.

3. Wrap the product with polyethylene sheeting or equivalent material.

4. If the original packing material and carton are not available, obtain a corrugated cardboard shipping carton with inside dimensions that are at least 6 in. (15 cm) taller, wider, and deeper than the product. The shipping carton must be constructed of cardboard with a minimum of 375 lb. (170 kg) test strength. Cushion the instrument in the shipping carton with packing material or urethane foam on all sides between the carton and the product. Allow 3 in. (7.5 cm) on all sides, top, and bottom.

5. Seal the shipping carton with shipping tape or an industrial stapler.

6. Ship the product to:
   Coherent, Inc.
   27650 SW 95th Ave.
   Wilsonville, OR 97070
   Attn: RMA # (add the RMA number you received from Coherent Customer Service)
APPENDIX A: SPECIFICATIONS

For an up-to-date list of all compatible sensors and their specifications, visit our website: www.Coherent.com/LMC.
APPENDIX B: TROUBLESHOOTING AND ERROR MESSAGES

The PowerMax PC application crashes or is forced to quit

If the application crashes or is forced to quit, PowerMax sensors connected to the computer may not properly release from remote mode.

To clear the error: Disconnect and then reconnect the USB cable on each of the affected sensors.

An error message displays when the last sensor is removed

The PowerMax PC application displays a communications error if all PowerMax sensors are removed from the computer while the application is running. This error message operates as a reminder that there are no sensors available for data collection.

To clear the error: Select OK in the error window(s). Reconnect the sensor to the computer and then click the Select Sensor button to continue.

An error message displays when a sensor is removed while acquiring data

The PowerMax PC application displays error windows if a sensor is removed while that sensor is streaming data. Data collection must be stopped before removing a sensor that is being used to collect data.

To clear the error: Select OK in the error window(s). Reconnect the sensor to the computer and then click the Select Sensor button to continue; or, select File > Exit, to exit the software.

Failed communications error

The PowerMax PC application displays an error if a communications failure occurs while reading sensor parameters.

To clear the error: Click the OK button.
# Index

## A
- Advanced procedures 4-1

## C
- Cable length, extending 3-3
- Calibration 6-1
- Coherent calibration facilities and capabilities 6-1
- Compliance
  - RoHS ix
  - U.S. export control laws ix

## D
- Data streaming transmission interface 5-22
- Declaration of Conformity 1-1

## E
- Error messages B-1
- Extended warranty 6-2

## F
- Features
  - Product 2-1
  - Software 2-2
- File menu 3-30
- Front panel 3-8

## H
- Help menu 3-42
- Host command quick reference 5-3
- Host interface 5-1
  - Data streaming transmission interface 5-22
  - Host command quick reference 5-3
  - Legacy LaserPAD/SSIM interface 5-17
  - Message terminators 5-2
  - Operational parameters 5-23
  - SCPI interface 5-5

## I
- Interface
  - Data streaming transmission 5-22
  - Host 5-1
  - Legacy LaserPAD/SSIM 5-17
  - SCPI 5-5

## L
- LED status indicators 3-1
- Legacy LaserPAD/SSIM interface 5-17
- Limited warranty 6-2

## M
- Menu
  - File 3-30

## R
- RoHS compliance ix
- RS sensors, powering 3-2
- RS-232 port settings 5-24

## S
- Safety 1-1
  - Declaration of Conformity 1-1
  - Waste Electrical and Electronic Equipment (WEEE, 2002) 1-1
- SCPI interface 5-5
- Service, obtaining warranty 6-3
- Settings
  - Menu 3-34
  - RS-232 port 5-24
- Shipping instructions, product 6-4
- Software
  - Features 2-2
  - Front panel 3-8
  - Menus 3-29
- Status indicators, LED 3-1
- Symbols used in this document vii

## T
- Technology
  - Thermopile 2-3